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Welcome to the QuickBooks Software Development Kit (SDK) Version 4.0. This 
software is designed for use with QuickBooks 2005; selected features of this 
software can be used with QuickBooks 2002, 2003, and 2004 as well. 
The system requirements for the QuickBooks SDK are the same as those for the version of 
QuickBooks that is running. QuickBooks 2005 and 2004 will run on Microsoft Windows 98, 
2000, Me, or XP operating systems. QuickBooks 2002 and 2003 will run on Windows NT, 98, 
2000, Me, or XP operating systems.(The SDK does not run in unattended mode—that is, with 
automatic login—on Windows 98, First Edition; it does, however, run in unattended mode on 
Windows 98, Second Edition.)
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Support for QuickBooks Products

The following table lists the different versions of QuickBooks and the 
corresponding versions of the qbXML specifications that support them. (Note: 
QuickBooks Basic, QuickBooks Simple Start Desktop Edition, or the Canadian 
QuickBooks  Easy Start Edition do not support the SDK.)

Version of QuickBooks
qbXML Specification 
Version

QuickBooks 2005 (and Enterprise 5.0)
(using QBXMLRP2) 

4.0, 3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2005 (and Enterprise 5.0)
(using QBXMLRP) 

 2.1, 2.0, 1.1, 1.0 

QuickBooks 2004 (and Enterprise 4.0)
(using QBXMLRP2) 

3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2004 (and Enterprise 4.0)
(using QBXMLRP) 

2.1, 2.0, 1.1, 1.0

QuickBooks 2003 (R7 and above)
(and Enterprise 3.0)*

2.1, 2.0, 1.1, 1.0

QuickBooks 2003
(and Enterprise 2.0)*

2.0, 1.1, 1.0

QuickBooks 2002 (R2 and above)
(and Enterprise)*

1.1, 1.0 

QuickBooks 2002 (R1)* 1.0

QuickBooks Online Edition (v. 11) 4.0, 3.0, 2.1, 2.0

QuickBooks 2005, Canadian Edition
(using QBXMLRP2) 

CA3.0, CA2.0

QuickBooks 2005, Canadian Edition
(using QBXMLRP)

CA2.0

QuickBooks 2004, Canadian Edition
(using QBXMLRP2) 

CA3.0, CA2.0 

QuickBooks 2004, Canadian Edition
(using QBXMLRP)

CA2.0

QuickBooks 2003, Canadian Edition* CA2.0
*Earlier releases of QuickBooks will work with either version of the Request Processor (QBXMLRP2 or 
QBXMLRP). We recommend you upgrade existing applications to use QBXMLRP2. SDK 3.0 and greater features are 
available only with QBXMLRP2; in addition, this Request Processor solves some problems found in the older Request 
Processor.
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The following table lists the different versions of the QuickBooks Foundation 
Class (QBFC) Library and the versions of the qbXML specification that support 
them.

Installation Instructions

IMPORTANT

During SDK 4.0 installation, if the eBay SDK has 
previously been installed on your system, the SDK 4.0 
installer may report a failure registering ebay.SDK.tlb. 
This error can safely be ignored and the installation 
will proceed normally.

To install the SDK using the installer, execute QBSDK40.exe. The installer 
also adds a menu (Start>Programs>QuickBooks SDK 4.0>) that provides 
convenient access to SDK tools, samples, and documentation (including the 
Onscreen Reference). You can also access the qbXML Validator and qbXML 
Test applications through the "Send To" context menu for files.

Registering an Application for QuickBooks Online Edition

Before an application can connect with QuickBooks Online Edition using the 
SDK, it must be registered with the Intuit Developer Network. To register 
your application and obtain an application ID, please follow the instructions in 
Chapter 3 of the Developer's Guide for QuickBooks Online Edition and visit 
http://appreg.quickbooks.com to register your application.

QBFC Library qbXML Specification 
Version

QBFC4
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

4.0, 3.0, 2.1, 2.0, 1.1, 
1.0, CA3.0, CA2.0

QBFC3
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

3.0, 2.1, 2.0, 1.1, 1.0, 
CA3.0, CA2.0

QBFC2_1
   (including support for QuickBooks Online Edition)

2.1, 2.0, 1.1, 1.0

QBFC2 2.0, 1.1, 1.0

QBFC2CA CA2.0

QBFC 1.1, 1.0
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Importing the Correct Library

For Visual C++ applications (if you are not using the QBFC Library), you need 
to import the library named qbxmlrp2.dll, which is installed in C:\Program 
Files\Common Files\Intuit\QuickBooks. For Visual Basic applications, select 
Project > References from within your VB project. Find “QBXMLRP2 1.0 Type 
Library” in the list and check the box next to it, then click OK. If you don’t 
find the entry in the list, you can browse to it.

Migrating QBFC Applications to Version 4.0

If you want to use SDK 4.0 requests, you will need to change QBFC code to 
refer to the new QBFC Library. For example, in Visual Basic, replace 
“QBFC3Lib” or “QBFC3bLib” with “QBFC4Lib.” 

If you are currently using QBFC and want or need to be able to use the new 
QBFC dll (qbfc4.dll), you may need to make a few changes to your code and 
recompile even if you continue specifying the 3.0 version of the qbXML spec 
in the call to CreateMsgSetRequest. Specifically, the following change(s) are 
required:

• Replace any reference to the QBXMLRPConnectionType and its enum 
values (unknown, localQBD, remoteQBD) with the new SDK 4.0 
ENConnectionType enum type and its values (ctUnknown, ctLocalQBD, 
ctRemoteQBD, ctLocalQBDLaunchUI, and ctRemoteQBOE).

• For QBD, in a ChargeQuery, ORTxnQuery has been changed to 
ORChargeTxnQuery.  (For Canada, ORTxnQuery is still used; for QBOE, 
there is no change because QBOE doesn't support ChargeQuery.)

• For QBD, in InvoiceLineAdd/Mod, CreditMemoLineAdd/Mod, 
SalesOrderLineAdd/Mod, and SalesReceiptLineAdd, ORRate is changed to 
ORRatePriceLevel.  For QBOE, in InvoiceLineAdd, CreditMemoLineAdd, 
and SalesReceiptLineAdd, ORRate is changed to ORRatePriceLevel, even 
though the new PriceLevelRef in ORRatePriceLevel is not available in 
QBOE. For Canada, ORRate is still used, so no change is needed.

See the Developer's Guide for the QBFC Library for additional tips on 
migrating QBFC applications to a new SDK version.
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New or Modified Files of Interest

This release includes documentation, tools, and samples. The following files 
and directories may be of particular interest to you:

• This release includes .NET Primary Interop Assemblies (PIAs) for 
QBXMLRP2, QBFC4, QBFC3, and QBFC2.1. These assemblies are included 
in the redistributable installers and merge modules for each library. If you 
have previously built a local interop assembly for use with your .NET 
integrations, please be sure to update them to use the primary interop 
assemblies included with this release instead.

• doc\qbxmlops40.xml
The sample file containing all qbXML requests and responses.

• OSR\OnscreenRef
The Onscreen Reference for SDK 4.0. 

• QBOE connector
Installed in the Windows Program Files\common files\Intuit\QuickBooks 
directory. Provides transparent and easy connectivity to QuickBooks 
Online Edition. This plugin to the QBXMLRP2 request processor is 
redistributable via the following installer and merge modules: 
QBOEConnector.msm (merge module) and QBOEConnector_Installer.exe 
(installer).

• MS Visual Studio integrated help files located at:[QBSDK4.0]\VSHelpFiles.

• samples\qbdt\vb\qbxml\DataEvents\QBDataEventSubscriber
Modified to show how to subscribe to events and specify that you don’t 
want to receive your own events.

• samples\qbdt\vb\qbxml\DataExtSample 
Modified to show use of IncludeRetElement to limit returned data to only 
what was specified.

• samples\qbdt\vb\qbxml\SDKTestPlus3
Modified to show the new OpenConnection2 method that allows the new 
connection types (such as the transparent connection to QB Online 
Edition) and to show how to support the new user authorization 
preferences feature.

• samples\qbdt\vb.NET\QBFC\ItemReceipt
Shows the use of the new ItemReceipt functionality.

• samples\qbdt\vb.NET\QBFC\PriceLevels
Shows the use of the new PriceLevel functionality.

• samples\qbdt\vb\qbfc\MenuEventContext
Sample code that shows how to add menus to QuickBooks and get 
information about which forms (if any) are open in QuickBooks at the time 
the menu is chosen.
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• samples\qbdt\vb.NET\qbXML\DotNetEvents
Shows how to implement the request proxy executable that is required to 
enable .NET applications to receive QuickBooks events. 

• samples\xmlfiles\CustomerQuery_metadata.xml: shows the use of the 
new metadata feature, used to get approximate counts of objects that 
would be returned in the query, without returning the object data.

• samples\xmlfiles\TxnDisplayAdd_Invoice.xml: shows the new prefilling 
feature. This file causes the display of the QB Create Invoice form, 
prefilled with a customer name. When the end user tabs out of the Create 
Invoice form, the remaining customer data will appear in the form as well.

All new samples require QuickBooks 2005, the QBXMLRP2 Request Processor, 
and the QuickBooks 2005 sample product-based company file. The QBXMLRP2 
Request Processor is installed in a variety of ways: automatically by 
QuickBooks 2005 and by the redistributable QBXMLRP2_Installer.exe installer 
and QBXMLRP2.msm merge module. The SDK also installs the request 
processor.

Enterprise Solutions version 5.0 and the SDK 

The release of QuickBooks 2005 coincides with a new release of QuickBooks 
Enterprise Soutions, version 5.0.  Enterprise Solutions version 5.0 provides 
new features and enhancements, one of which is a greater degree of flexibility 
in assigning user permissions to access QuickBooks,  a feature that was 
provided by Intuit in response to many customer requests.

Enterprise Solutions version 5.0 continues to support and is compatible with 
the SDK, including the user/permissions enhancements, which should not 
affect most SDK applications. However, in certain cases, some permissions 
may work in ways that an SDK application needs to anticipate, in order to 
provide a good experience for the customer. These are listed in the bulleted 
items below:

• A user with only AP permission used to be able to see the report for 
Physical Inventory Worksheet.  With Enterprise 5.0, the user now requires 
view access under inventory.

• A user with all permissions except AP and Sensitive Account previously 
could see the report PurchaseByVendorSummary but with Enterprise 5.0 
cannot see this without view permissions for purchases.  (The former 
ability to see this report was actually a bug, so the new behavior is the 
proper behavior.) 

• A user with with Payroll and Employees access previously could request 
the TimebyJobDetail report. With Enterprise 5.0, the user cannot access 
this report without permissions for View access for Time.
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• Previously, access to the report Transaction list by Customer was not 
allowed unless the user had Sensitive Reports permission, but with 
Enterprise 5.0, this access is allowed. 

Documentation

This release includes new SDK manuals in both PDF and HTML. Along with the 
other major features in the SDK, the manuals and the Onscreen Reference 
can be conveniently accessed through the Start menu.
For best results, use Internet Explorer version 6 or higher to view the 
Onscreen Reference. If you use Netscape Navigator or Mozilla FireFox, for 
example, you may not be able to view all the information.

Tools

New in the SDK release is an SDK plugin for the Visual Studio 2003 IDE. If 
you have this version of the IDE and install the plugin, you will see 
"QuickBooks SDK 4.0" in the table of contents. You will also have F1 access to 
all QBFC interfaces for the messages and the VB.NET sample code inside 
Visual Studio.

The qbXML Validator tool contains new functionality that allows you to 
verify qbXML requests that correspond to these combinations:

- 4.0, 3.0, 2.1, 2.0, 1.1, 1.0 for U.S. editions of QuickBooks

- 4.0, 3.0, 2.1, and 2.0 for QuickBooks Online Edition

- CA3.0 and CA2.0 for Canadian editions of QuickBooks

The Validator is installed automatically as part of the SDK installation.  

The SDKTest application is located in the \tools\SDKTest folder.  This useful 
development tool reads a qbXML request file, sends it to QuickBooks, and 
returns a response. The command line version of SDKTest is 
samples\qbdt\cpp\qbxml\sdktest\sdktest.exe.
The file tools\SDKTest\SDKTestPlus3.exe is an enhanced version of SDKTest 
that uses QBXMLRP2 and allows the user to control every aspect of the 
connection to QuickBooks. It supports sending subscription request XML as 
well as data integration XML. The source code for this tool is in 
samples\qbdt\vb\qbxml\SDKTestPlus3.
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The file tools\SubscriptionManager\SubView.exe is a tool for viewing and 
removing application subscriptions from QuickBooks.

Samples

The Samples directory contains a readme.html (which can be accessed from 
Start > Programs > QuickBooks SDK 4.0 > Samples). This file lists each 
sample and provides links to open the project directory, the project itself, and 
the executable form of the application.

The SDK 4.0 installer verifies that the MSXML4.0SP2 API from Microsoft is 
installed on your system. If MSXML is not present, the SDK 4.0 installer will 
install it for you. This API is used by the SDK’s Validator tool and several 
samples. 

Downloading MSXML 4.0

If you want to run the sample applications on a system that does not have 
MSXML installed (for example, if you want to use Remote Data Sharing from 
a system that does not have the SDK installed), you will need to install 
MSXML. In addition, if your application is dependent on MSXML Core 
Services, you will need to redistribute that software in your installer. The 
MSXML Core Services software is available from Microsoft

Building the C++ Samples

The #import “qbxmlrp2.dll” statement in the C++ samples allows these 
applications to use the COM interface supported by the QuickBooks SDK. This 
statement will cause an error when you are building the samples in Microsoft 
Visual Studio if the Include path is not set to include the location of this DLL. 
The DLL is installed with QuickBooks and resides in the QuickBooks common 
directory, currently defined as 
C:\Program Files\Common Files\Intuit\QuickBooks. Add this directory to the 
Include path by choosing the Tools menu, Options command, and the 
Directories tab in Visual Studio.
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UIandEventTest Samples

In order to build the EventHandler C++ sample, you will need to specify the 
QuickBooks executable path for the sample project. The method for doing this 
is different for Visual Studio 6.0 and Visual Studio .NET. 

For Visual Studio 6.0, select "Options" from the "Tools" menu. Select the "Di-
rectories" tab and then select "Executable Files". Add the QuickBooks execut-
able path to the list of directories here.

For Visual Studio .NET, select "Properties" from the "Project" menu. Under the 
"C/C++" options, select "General" and add the QuickBooks executable path to 
the "Additional Include Directories". Under the "MIDL" options, also select 
"General" and add the QB path to "Additional Include Directories".

All of these C++ samples also use QBXMLRP2.DLL in the QuickBooks 
"common" directory. The project files currently specify this path as 
C:\Program Files\Common Files\Intuit\QuickBooks. If this path is different on 
your machine, you will need to change it in the project files.

Known Problems in VB Sample Applications

The Visual Basic sample applications allow you to view a response from 
QuickBooks. If you try to view a response that is greater than 32K, you will 
receive an “Out of memory” error.  This happens because the VB sample 
applications use a TextBox control, which has a 32K limit, rather than a 
RichTextBox control. In a Windows 98 or Windows Me environment, this can 
corrupt memory, and the application might not terminate properly.

There is a known issue (not related to qbXML) with the AddReceivePayment 
sample application. The MS Visual Studio application must be installed before 
you can run AddReceivePayment, or you will receive the following error 
message when you run the application: “Class not registered. You need the 
following file to be installed on your machine. MSSTDFMT.DLL.”

How Versioning is Handled in Subscriptions in SDK 4.0

The event data that is returned can potentially differ depending on the qbXML 
version. For example, in the 4.0 qbXML spec, there is a new tag that could be 
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returned in the QBXMLEvent response called CurrentWindow. If an application 
is designed for the 3.0 spec but not the 4.0 spec, how is this situation handled? 

Beginning with SDK 4.0, the spec version that issued the original subscription 
request determines which data is returned in the response. For example, if 
your application subscribed using qbXML 3.0 (that is, the qbXML version tag is 
set like this: <?qbxml version="3.0"?> ), then the QBXMLEvent data that is 
returned is the data from 3.0, that is, you don't receive additional data made 
available in 4.0.If you needed that data, you would resubscribe using a qbXML 
4.0 subscription request.

In addition, suppose you have a current subscription issued using qbXML 3.0. 
To delete that subscription, you have to issue a SubscriptionDel request with 
the qbXML version tag set to 3.0. The reason for this is that you might want 
to keep 3.0 spec subscriptions for backwards compatibility.

Using Payroll Reports

If your application is accessing a company file that is currently signed up for a 
subscription to a payroll service, you can generate payroll reports and query 
PayrollNonWageItems.

To test this feature, you can use one of Intuit’s sample company files (even 
though it will not be signed up for a subscription to a payroll service). Please 
be aware that QuickBooks will record an artificial creation date to any test data 
that you add to a sample company file.

Using Remote Data Sharing (RDS)

This release includes a redistributable version of Remote Data Sharing 3.0. 
RDS 3.0 works only for applications using QBXMLRP2. Please note that RDS 
3.0 does not support event notification or user interface extensions.

Beginning with SDK 3.0, the Remote Data Sharing (RDS) server supports 
automatic login mode, also called batch mode. In this access mode, 
QuickBooks is installed but not running on the machine with the RDS server. 
Instead, the QuickBooks user authorizes the RDS server to log in automatically 
to the desired set of company files. Subsequently, remote applications can 
access any of these company files. 

Applications using the older Request Processor (QBXMLRP) should use RDS 
2.1.
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Known Bugs and Workarounds

• During SDK 4.0 installation, you may see a message informing you that 
the UI and eBay sample could not be installed. You can safely ignore and 
dismiss this message as it has no effect and the installation will proceed 
successfully.

• The bug mentioned in this workaround is fixed in SDK 4.0. However this 
workaround is included here for those applications that need to work with 
older QuickBooks versions for which the bug fix is not available. In 
previous versions of the SDK, if you send an InventoryAdjustmentAddRq 
with a ValueAdjustment that contains only a NewValue element, then the 
resulting QuantityDifference will incorrectly get set to "blank", which 
QuickBooks interprets as "1".  The workaround for this is to include the 
NewQuantity element in the request, setting the value to the same as the 
previous quantity on hand for that inventory item.

• If you use DeliveryPolicy in both a DataEventSubscription and a 
UIEventSubscription, you could set one to DeliverAlways and the other to 
DeliverOnlyIfRunning. In that case, QB will cache your application’s COM 
pointer if the first event for this application in a company file session is 
associated with the DeliverAlways policy.

• If a user installs a copy of Convertible QuickBooks 2005 but does not 
select one of the available editions (Premier, Accountant, Contractor 
edition, etc), and an SDK application is subsequently started, QuickBooks 
will prompt the user to select an edition. The application’s call to 
BeginSession will fail while QuickBooks is being configured for the 
selected edition. The workaround is to have the user finish the process of 
selecting the desired edition and then restart the SDK application.

• In Enterprise 5.0, if a user name has been used by an SDK application for 
auto-login purposes, and the Administrative user deletes that user name, 
there is no warning dialog posted to alert the administrative user, unlike 
prior releases, and unlike current behavior in other QuickBooks 2005 
editions. However, if the user is deleted, the SDK application will fail 
gracefully the next time it attempts to auto-login, and the appropriate 
error message is displayed so the user can have the administrative user 
add that user name.

• QuickBooks Canada does not currently return values stored in the 
Company Data Extension fields.  The bug affects QuickBooks Canada 
version 2004 and 2005.
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Bugs Fixed in This Release

• Starting with SDK 4.0, the SDK now prevents applications from setting 
rate/ratepercent on sales tax items, to be consistent with the QuickBooks 
UI where it is not possible to set rate/ratepercent on sales tax items. 
However, in order to support existing applications that do not send 4.0 or 
greater requests, the old behavior will continue to be in effect.

• Prior to SDK 4.0, the "unused credit” in the ReceivePaymentRet object 
returned the available credits for the given customer job AND its children. 
In SDK 4.0 and after, the ReceivePaymentRet object returns only the 
available credits (unused credits) for the given customer job only, not the 
children.

• In prior releases of the SDK, the requestID was not getting encoded 
correctly if it contained ", ', &, >, or <, or their escaped equivalents. This 
has been fixed in SDK 4.0.

• Starting with SDK 4.0, modifications to the Notes field will result in a mod 
event for the object containing the Note.

• In previous releases, transactions containing ItemInventoryAssembly 
could not be modified. This is fixed in this release.

• The SDK used to return Internal Error if setting the DiscountPct on a 
DateDrivenTerms ever failed. Now the status code 3210 “Other validation 
error” is returned instead.

• Previously, if an attempt was made to change a parent object in multiuser 
mode and this element or its descendants has been used in a transaction, 
the error returned was "parent reference not found". Now, the error 
returned is "not allowed in multiuser mode."

• In previous SDK versions, if you were logged in as a user without sensitive 
accounting permission and specified IncludeLinkedTxns on a transaction 
query (for example, InvoiceQueryRq), then you would not receive the link 
info, even if you had permissions to access that particular linked 
transaction data. Furthermore, the error would be written only silently to 
the log file. In this SDK release, under this same scenario, you will get the 
linked transaction data.

• “Sensitive report" permissions are no longer required in transaction 
queries.

• In prior SDK releases, the SDK was not able to set the quantity to 1 on a 
line containing a fixed asset item. Both of these bugs have been fixed in 
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this release. Now, a line item quantity can be empty or 1 for fixed asset 
items. 

• In previous SDK releases, a request for adjusting only the inventory value 
also increases the quantity on hand for the item. This has been fixed in 
this release so that the quantity difference is zero when only a NewValue 
is provided in the SDK request. See “Known Bugs and Workarounds” for 
information on solving this problem for previous versions of QuickBooks.

• Previously, for subscriptions using the DeliverOnlyIfRunning policy the 
application’s COM pointer was cached once the user starts the app. 
Consequently even if the application were terminated from its own UI, 
QuickBooks would continue sending events to the application. This has 
been fixed in this release.

• Previously, for a subscription callback application, when its path was read 
from the registry, incorrect data was being read. For example if there are 
any flags in the registry entry, such as "c:\some dir\callback.exe" -f -g, 
the flags were being read as part of the path. Now, these flags are 
ignored.

• Prior to SDK 4.0, if you used CustomSummaryReportQueryRq but did not 
specify the ReportAccountFilter, then by default the account filter used 
was "All accounts,” which is not the default filter used in the QuickBooks 
UI. The default account filter for 4.0 requests is "All income/expense 
accounts." Notice that if you specify a request lower (e.g., 3.0 or 2.1) than 
4.0, then the old default is used, in order to avoid breaking existing 
applications.

• In previous SDK releases, the SalesOrderMod operation was not allowed 
for Quickbooks Pro, even though this modification was allowed in the 
QuickBooks Pro UI. This operation is now supported in QuickBooks Pro. 
However, notice that SalesOrderAdd continues to be disallowed for Pro 
because this functionality is available only with Premier and greater 
editions.

• This release fixes some memory leaks that could potentially occur in some 
SDK applications under previous releases of the SDK.

• Prior to Enterprise 5.0, an Enterprise user with all permissions except AP 
and Sensitive Account previously could see the report 
PurchaseByVendorSummary. This bug has been fixed. The user in 
Enterprise 5.0 cannot see this report without view permissions for 
purchases.
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Changes to the qbXML Specification

• For the element <DueNextMonthDays>, the SDK now enforces the 
validation constraints. Now, if you use an invalid INTTYPE for 
<DueNextMonthDays> such as 0 or 32 then you will get back a data 
validation error.

If You Have Questions . . .

For IDN support, please visit http://developer.intuit.com/support.

For community support, visit http://idnforums.intuit.com.

Related AlphaGeek Technical Articles on New Features

For information on the new SDK 4.0 A/P Transaction Linking features, as 
described in the AlphaGeek column on A/P Transaction linking, click here.

For information on the new SDK 4.0 Price Levels feature, as described in the 
AlphaGeek column on Price Levels, click here.

For information on the new SDK 4.0 Authorization Preferences feature, as 
described in the AlphaGeek column on Application Authorization, click here.

For information on the QBOE connector, integration of SDK 4.0 with the Visual 
Studio .Net help system, generic transaction queries, and limited responses, 
click here.
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Summary of New Features

This summary is divided into two parts. The first part provides an overview of 
the changes to QuickBooks SDK in Release 4.0. The second part provides a 
detailed listing of changes at the message and element level. 
Note: The new features listed below apply to QBOE only if explicitly stated.

Part One: Overview of Changes in SDK 4.0

Several highlights of this release have already been described in these 
Release Notes. These highlights include

• New support for PriceLevels: PriceLevelAdd/Mod/Query

• New support for ItemReceipt: you can now add and modify ItemReceipts, 
and you can link a new Bill or ItemReceipt with a PurchaseOrder (A/P 
transaction linking)

• A generic transaction query and associated filters that you can use to 
implement your own version of the QB Advanced Find functionality, and 
query across all QB transaction types.

• Enhancements to user authorization. A new QBAuthPreferenes property of 
the RequestProcessor allows application to request (from the user):
-read-only access to a particular company file
-unattended mode access
- personal data access
QuickBooks subsequently displays an authorization form that contains the 
requirements specified in the new QBAuthPreferences property (new 
behavior in QuickBooks itself).

• Enhancements to integration with QB UI:
-ability to launch QB transaction creation forms prefilled with data, such 
as customer, vendor, etc, as appropriate to the transaction type.
-ability to launch QB in the foreground in unattended mode, showing its 
UI, with a specified company file open
-ability to detect context data such as which QB form is open, if any, when 
the user clicks your custom menu
--extend the existing ListDisplayAdd/Mod functionality to include Account 
and Item forms

• Enhancements to subscription to data events:
-ability to block subscribed-to data events if you generated them in your 
application.
-ability to automatically handle qbXML versions in the various subscription 
requests (see the Event Notication chapter in the Concepts manual for 
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more information)

• Ability to limit response data to a specific element or set of elements 
(supports top-level elements or aggregates)

• Ability to query for the number of objects that may be returned in a 
particular query (metaData)

• A variety of enhancements to the SDK runtime for QBOE:
-A QBOE connector that handles all of the special communication required 
by QB Online Edition. This eliminates the special coding that was formerly 
required by desktop applications, greatly simplifying the porting or 
creating of applications that work with QBOE.

-Added the following support for SalesReceiptAdd, InvoiceAdd, and 
CreditMemoAdd:
--Added the DiscountLineAdd/Ret aggregates
--Added the SalesTaxLineAdd/Ret aggregates
--Added the ShippingLineAdd/Ret aggregates

-Added the IsTaxable Boolean type to the following:
--InvoiceLineAdd/Ret
--SalesReceiptLineAdd/Ret
--CreditMemoLineAdd/Ret

-Added support for APAccountRef in the following:
--BillAdd/Ret
--VendorCreditAdd/Ret

-Added the ability to link to transactions in BillAdd.

• This release adds one Report Item filter and four Report Transaction 
filters. It adds the AllExceptFixedAsset filter to the ReportItemFilter and 
the BuildAssembly, Paycheck, PayrollLiabilityCheck, and YTDAdjustment 
filters to the ReportTxnTypeFilter.

• The UI for the Validator tool has been improved. It now supports longer 
error messages and the error messages can now be copied into the 
Windows clipboard.
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Transaction Query Filter Support in QuickBooks Online 
Edition 

Beginning with SDK 4.0, QBOE supports an enhanced list of transaction query 
filters. The Onscreen Reference lists and describes the filters that are 
provided for transaction queries in QBOE.

However, notice that these query filters are not yet implemented, but are 
expected to be fully implemented shortly after the release of QuickBooks 
2005. Any developers who need to use these query filters are encouraged to 
contact IDN Support.

Part Two: Details of Changes in SDK 4.0

The following sections contain details on new request and response messages 
as well as on new and changed elements within response aggregates. See the 
updated Onscreen Reference for complete listings of all messages. Also see 
the example file qbxmlops40.xml.

Table 1:  New Requests/Responses in SDK 4.0

Table 2:  Elements Added to Requests in SDK 4.0

The following items are not listed in the tables because they are almost 
universal and would obscure other important changes if they were listed 
separately:

• IncludeRetElement has been added to nearly all requests

• The metaData attribute has been added to most Query requests

• The RefNumberCaseSensitive element ,has been added to most Query 
requests

Request Category
ItemReceiptAdd Transaction
ItemReceiptMod Transaction
TransactionQuery Transaction
PriceLevelAdd List
PriceLevelMod List
PriceLevelQuery List
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Request Element Added Category
CustomerAdd PriceLevelRef List
CustomerMod PriceLevelRef List
InvoiceAdd PriceLevelRef Transaction
InvoiceAdd IsTaxable (QBOE only) Transaction
InvoiceAdd  DiscountLineAdd (QBOE 

only)
Transaction

InvoiceAdd SalesTaxLineAdd (QBOE 
only)

Transaction

InvoiceAdd ShippingLineAdd (QBOE 
only)

Transaction

InvoiceMod PriceLevelRef Transaction
SalesOrderAdd PriceLevelRef Transaction
SalesOrderMod PriceLevelRef Transaction
SalesReceiptAdd PriceLevelRef Transaction
SalesReceiptAdd IsTaxable (QBOE only) Transaction
SalesReceiptAdd  DiscountLineAdd (QBOE 

only)
Transaction

SalesReceiptAdd SalesTaxLineAdd (QBOE 
only)

Transaction

SalesReceiptAdd ShippingLineAdd (QBOE 
only)

Transaction

CreditMemoAdd IsTaxable (QBOE only) Transaction
CreditMemoAdd  DiscountLineAdd (QBOE 

only)
Transaction

CreditMemoAdd SalesTaxLineAdd (QBOE 
only)

Transaction

CreditMemoAdd ShippingLineAdd (QBOE 
only)

Transaction

CreditMemoMod PriceLevelRef Transaction
ChargeQuery PaidStatus
BillAdd LinkToTxnID Transaction
BillAdd LinkToTxn Transaction
VendorCreditAdd LinkToTxn Transaction
CheckAdd LinkToTxn Transaction
CreditCardChargeAdd LinkToTxn Transaction
page 18
 (c) 2004 Intuit Inc. All rights reserved.



CreditCardCreditAdd LinkToTxn Transaction
TxnDisplayAdd EntityRef UI
Page 19
 (c) 2004 Intuit Inc. All rights reserved.



Table 3:  Elements Added to Responses and Response 
Aggregates in SDK 4.0

Response/Resp. Aggregate Element Added Category
PreferencesQuery PriceLevels
CustomerAdd PriceLevelRef Transaction
CustomerMod PriceLevelRef Transaction
InvoiceAdd IsTaxable (QBOE only) Transaction
InvoiceAdd  DiscountLineRet (QBOE only) Transaction
InvoiceAdd SalesTaxLineRet (QBOE only) Transaction
InvoiceAdd ShippingLineRet (QBOE only) Transaction
InvoiceMod IsTaxable (QBOE only) Transaction
InvoiceMod  DiscountLineRet (QBOE only) Transaction
InvoiceMod SalesTaxLineRet (QBOE only) Transaction
InvoiceMod ShippingLineRet (QBOE only) Transaction
InvoiceQuery IsTaxable (QBOE only) Transaction
InvoiceQuery  DiscountLineRet (QBOE only) Transaction
InvoiceQuery SalesTaxLineRet (QBOE only) Transaction
InvoiceQuery ShippingLineRet (QBOE only) Transaction
SalesReceiptAdd IsTaxable (QBOE only) Transaction
SalesReceiptAdd  DiscountLineRet (QBOE only) Transaction
SalesReceiptAdd SalesTaxLineRet(QBOE only) Transaction
SalesReceiptAdd ShippingLineRet(QBOE only) Transaction
SalesReceiptQuery IsTaxable (QBOE only) Transaction
SalesReceiptQuery  DiscountLineRet (QBOE only) Transaction
SalesReceiptQuery SalesTaxLineRet(QBOE only) Transaction
SalesReceiptQuery ShippingLineRet(QBOE only) Transaction
CreditMemoAdd IsTaxable (QBOE only) Transaction
CreditMemoAdd  DiscountLineRet (QBOE only) Transaction
CreditMemoAdd SalesTaxLineRet (QBOE only) Transaction
CreditMemoAdd ShippingLineRet(QBOE only) Transaction
CreditMemoMod IsTaxable (QBOE only) Transaction
CreditMemoMod  DiscountLineRet (QBOE only) Transaction
CreditMemoMod SalesTaxLineRet (QBOE only) Transaction
CreditMemoMod ShippingLineRet(QBOE only) Transaction
CreditMemoQuery IsTaxable (QBOE only) Transaction
CreditMemoQuery  DiscountLineRet (QBOE only) Transaction
CreditMemoQuery SalesTaxLineRet (QBOE only) Transaction
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Table 4:  Enumeration Changes in SDK 4.0

CreditMemoQuery ShippingLineRet(QBOE only) Transaction

Enum Type Enum Value Added Category
ListDisplayAdd Item, Account UI
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Table 5:  Summary of Changes to Reports in SDK 4.0

Filter Added Report or Filter Type
AllExceptFixedAsset  ReportItemFilter
BuildAssembly, Paycheck,
PayrollLiabilityCheck, and
YTDAdjustment

ReportTxnTypeFilter
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